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- HM WebCopy #
Product Information Ve 1%

Short Description

PROGRAM . HM WebCopy

VERSION 1.2

LANGUAGE :  English

SYSTEM :  All Windows versions (32 bit, 64-Bit)
AUTHOR :  Dipl.-Ing. Martin Haller

CATEGORY :  Shareware, Internet Utility
DESCRIPTION :  Copying HTML text from Web pages

and saving as local HTML file.

Product Support

HOMEPAGE :  http://hmse.biz.tm -+&
E-MAIL SALES . office@hmse.biz.tm
E-MAIL SUPPORT :  support@hmse.biz.tm

Share*It! Online-Shop

PROGRAM NUMBER : 300482355
PRODUCT INFO . Product Page <@
ORDER :  Online Order Page <@
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What is HM WebCopy il burtii @

Use HM WebCopy to copy and save the interesting part of a Web page as HTML file on your
computer without annoying banners, ads and navigation elements. Later you can read the saved
HTML file offline in piece. The saved HTML file contains a text structure and formatting as similar
as possible to those of the original part of the Web page. Optionally HM WebCopy adds the
source URL of the Web page and the saving date.

A Web page often contains about 30 % information only. The rest of the Web page consists of
advertising banners and navigation elements you are usually not interested in. Browser and offline
reader programs always save the whole Web page and optionally all linked Web pages with all
images and advertising banners, creating a lot of data trash and wasting much disk space this
way. In contrast, using HM WebCopy enables you to copy and save just exactly the information
you want.

If you want to copy a story which is divided into a sequence of Web pages, this is very easy too
when using HM WebCopy. Just display the Web pages in your browser one after the other, on
each page select the information you are interested in and save it with HM WebCopy to the same
target folder on your computer. HM WebCopy maps automatically the folder paths of the
hyperlinks referring to the other pages of the story so that the hyperlinks of the locally saved
HTML files still work well.

HM WebCopy BENUTZERHANDBUCH Seite 4 von 62



HM WebCopy

Supported Browsers (Overview) Vers, 1.2 |

Basically, HM WebCopy is able to cooperate with any Web browser which provides a way to copy
the selected area of a web page to clipboard in HTML format. Additionally, HM WebCopy provides
a browser extension (add-on) for the most common browsers, which implements the ability to
launch HM WebCopy straightly from within the user interface of the browser.

The following overview shows the Web browser supported with a browser extension. All browsers
are supported in 32-bit as well as 64-bit architectures.

Internet Explorer (IE):

All versions from IE6 up to IE11 are supported. It's recommended to use the latest IE version
installable on your Windows.

Mozilla Firefox (FF):
All versions as of Firefox 1.5 are supported, as well as all editions (Release, ESR, Developer).

Note: As of FF 46 up to and including FF 51 the setting 'xpinstall.signatures.required' in
'about:config' must be set to 'false' to be able to install the self-signed add-on. As of FF 52 this
setting is no longer necessary because a new version of the add-on is used which is signed by
Mozilla.

Pale Moon (PM):

Is supported as of PM 24. Pale Moon is a fork of Firefox 24. Note: Pale Moon does not contain an
EME module (= DRM plugin).

Basilisk (BA):
Is supported as of BA 4. Basilisk 4 is a fork of Firefox 55.

Waterfox (WF):
Is supported as of WF 52. Waterfox is a fork of Firefox.

Chromium (CR):

Is supported as of CR 59. Chromium is the open source browser developed by Google, not
containing the proprietary Google parts.

Google Chrome (CR):

Is supported as of CR 59. Google Chrome is based on Chromium, enhanced with proprietary
Google parts. Google Chrome is spyware. Therefore, it is discouraged from using this browser.

Opera (OP):

Is supported as of OP 46. Opera is a Chromium-based Web browser.

Vivaldi (VI):

Is supported as of VI 1.10. Vivaldi is ein Chromium-based Web browser.

Iron (IR):

Is supported as of IR 59. Iron is a Chromium-based Web browser without spyware.
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New in Version 1.2 et g

Program Version 1.2.0
Additional Functionality

e General: Apart from 'Internet Explorer' and 'Mozilla Firefox', now the following browsers are
support with add-ons:
Firefox ESR, Pale Moon, Basilisk, Waterfox, Chromium, Chrome, Opera, Vivaldi, Iron.

¢ Firefox-Add-on (Fx): Modifications for browser 'Pale Moon' added.
e Firefox-Add-on (WE): New implementation with WebExtension API.

e Chromium-Add-on (CR): New implementation with WebExtension API (usable for all
Chromium-based browsers).

Program Modifications

e HM WebCopy: Internet Explorer 10 and 11 compatibility implemented and tested.
¢ HM WebCopy: Windows 7/8.x/10 compatibility implemented and tested.

¢ HM WebCopy: Improved presentation on high resolution displays (DPI aware).

e HM WebCopy: Default for 'Formatting' in options changed to 'Minimal'.

e HM WebCopy: New Homepage and email forwarding addresses (hmse.biz.tm).

e HM WebCopy: Help themes updated.

e Firefox add-on (Fx): The add-on's ID changed to '{3D72687C-60F7-4F01-BA29-
B80OA1FA3C97D}".

e Setup: Detection of installed browsers improved and extended.
¢ All modules: Minor tweaks.

Bug Fixes

e HM WebCopy: In rare cases syntactically wrong URLs were generated.
¢ HM WebCopy: Launching the browser failed in Windows 7 and later (elevation problem).
e Setup: Wrong global Firefox add-on folder fixed.

Previous Program Versions

e New in Version 1.1
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Restrictions of the Shareware version HM “ﬁtﬁ"g @

You are allowed to use the unregistered Shareware version of HM WebCopy free within a 30 day
trial period.

During this trial period HM WebCopy offers you full functionality, so that you can test the
program thoroughly under real conditions.

The unregistered Shareware version inserts a registration note into the HTML text saved.

How to register the Shareware version see Order Information.
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: HM WebCopy
Technical Support et @

Registered and licensed users will get technical support directly from the Author of HM WebCopy:

Dipl.-Ing. Martin Haller
Software-Engineering & EDV-Beratung
Langkampfner Strasse 19
6330 Kufstein / Austria
support@hmse.biz.tm
http://hmse.biz.tm

How to register the shareware version see Order Information.

To report suggestions, modification requests and errors fill in the feedback form and send it to the
above email address. Thank you.
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Installation / Uninstallation e @

Overview

e Installation

o Main Installation (administrator)

- Installation for Additional Users
e Maintenance Installation

o Repair Installation

- Installation of Additional Components

o Uninstallation of Additional Components
e Uninstallation

> Main Uninstallation (administrator)

o Uninstallation for Additional Users

o Manual Uninstallation (administrator)

o Manual Uninstallation of Particular Browser Extensions (administrator)
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Installation Vers, 1.2 |

Main Installation
To install HM WebCopy you should follow these steps:

1. Download the self-extracting installation package (exe file) to a temporary folder of your
choice.

2. If you are using Windows NT/2000/XP or a later version of Windows make sure you are logged
in as user with administrative privileges.

3. Run the self-extracting HM WebCopy installation package (exe file) and follow the installation
instructions displayed.

Note: If you have a previous version of HM WebCopy installed on your computer, you need not uninstall the previous
version before. The setup program detects an existing installation and let you choose whether to update the older
version or to perform a completely new installation.

4. Next, read carefully the file readme.htm. It may contain further installation instructions.
Moreover, there you will find the requirements for running the current program version.
Readme.htm contains a complete list of all files and folders installed on your computer by the
setup.

The main installation copies all required files of HM WebCopy onto your computer accessable for
all users, and creates the user-own configuration data, program symbols and shortcuts for the
administrator user account.

Notes:

¢ HM WebCopy has a multi-lingual user interface. During main installation you have to install
all language packages (as long as available) you will need for all users of your computer. In
particular this applies to computers which are setup with multiple Windows user accounts with
different languages.

At the Product Homepage of the application you may find additional language packages for
downloading.

e How to register the Shareware version see Order Information.

e On completion of the installation you can delete the self-extracting installation package (exe
file) in the temporary folder. But it is recommended to keep a copy of the self-extracting
installation package (exe file) somewhere (e.g. in a backup) because you may need it later for
maintenance installation (repair, installation of additional components).

Installation for Additional Users

If you have created multiple user accounts on your computer, e.g. a restricted user account, you
have to run once again the installation package under each additional user account, which should
be able to use HM WebCopy, to create the user-own configuration data, program symbols and
shortcuts for this user:

1. If you are using Windows NT/2000/XP or a later version of Windows log in with that user
account the user-own installation should be performed for, e.g. a restricted user account.

2. Run the self-extracting HM WebCopy installation package (exe file) and follow the installation
instructions displayed.

ATTENTION: Windows possibly displays a dialog box you can use to log in as a user with
administrative privileges for running the installation program. Don't do this but choose the
option in this dialog box which will run the installation program under that user account you
are already logged in.

3. The installation program self-recognizes that it is a user-specific installation and displays the
program maintenance wizard form. Choose the option Install (user 'xxx' only) and start the
installation with OK.

Note: Only those program symbols and shortcuts are created the administrator has selected at the
main installation.

Installation of Browser Extensions (Add-ons)

All needed files and shortcuts of the browser extensions are installed readily by the main and user
installation described above. But usually, in most browsers (except Internet Explorer) you have to
activate additionally the installed browser extension by hand.
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1. Run the browser and open the browser's add-on manager via the corresponding menu
command (e.g. 'Tools > Add-ons').

2. In add-on manager, select the HM WebCopy extension and then click the associated button
'Activate' Or '"Install'.

Notes:

¢ Alternatively, some browsers (e.g. Firefox) request the confirmation for activation or
installation of the browser extension described above already when launching the browser.

e In Firefox 46 up to 51 and in some Firefox forks the setting 'xpinstall.signatures.required’ in
'about:config' must be set to 'false' to be able to install or activate the HM WebCopy
extension.

¢ In some browsers (e.g. Opera) the installed HM WebCopy extension is not shown in add-on
manager. In this case, in addition to the main installation you have to install the HM
WebCopy extension in add-on manager by hand:

o Open Windows Explorer and go to the HM WebCopy installation folder.

o Drag the installation package of the corresponding browser extension (e.g. 'hmwcwe.crx'
for Chromium-based browsers like Opera) by pressing and holding the left mouse button
from the Windows Explorer window into the opened window of the add-on manager in the
browser. The installation packages suitable for each browser are described in Browser
Extensions.

- Then, confirm the browser request for installation or activation of the HM WebCopy
extension.

Remark: The HM WebCopy extension's installation by hand described above works only if the
extension for this browser was selected in the previous main installation. If not, perform a
maintenance installation (installation of additional components) first and the extension's
installation by hand afterwards.

HM WebCopy BENUTZERHANDBUCH Seite 11 von 62



- : HM WebCopy @
Maintenance Installation et B

Repair Installation

The installation program of HM WebCopy provides a simple repair feature. If you have
erroneously deleted files, program symbols or shortcuts of HM WebCopy you can reinstall the
missing parts as follows:

Missing files

1. Under Windows NT/2000/XP and all later versions of Windows log in as user with
administrative privileges.

2. Run the self-extracting installation package (exe file) of HM WebCopy.

3. The installation program self-recognizes that it is a maintenance installation and displays the
program maintenance wizard form. Choose the option 'Repair (all users)' and start the
installation with Next.

4. On the wizard form 'Select Components' the components already installed are pre-selected.
Leave the selection unchanged and click Next to finish the installation.

Note:
Possibly you may have to repeat the activation of your user license after a repair installation.

Missing program symbols and shortcuts

In this case just repeat the user-own installation for the user account concerned as described in
installation, chapter ‘Installation for Additional Users'. The same applies to the addition of program
symbols and shortcuts for additionally installed components.

Installation of Additional Components

Normally, on main installation of HM WebCopy you install right from the start all optional
components needed (e.g. language packs, browser extensions). Nevertheless it may happen that
you have to install an optional component additionally, for instance, because you have installed a
new Web browser onto your system and now need the appropriate HM WebCopy browser
extension.

To install additionally an optional HM WebCopy component follow these steps:

1. Perform a repair installation as described above in chapter 'Repair installation’.

2. On the wizard form 'Select Components' choose the installation type 'Custom installation'
and select additionally those components you want to install. Leave the check state of all other
components unchanged. Then follow the installation instructions displayed to finish the
installation.

Note:
This way you can separately install additional components, but you can't separately uninstall
components already installed.

Uninstallation of Additional Components

The installation program of HM WebCopy can't uninstall optional components (e.g. language
packs, browser extensions) separately but only together with the HM WebCopy application.
However, you may uninstall particular browser extensions manually.
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Uninstallation et B

Main Uninstallation

To uninstall HM WebCopy you should follow these steps:

1. Under Windows NT/2000/XP and all later versions of Windows log in as user with
administrative privileges.

2. Open Windows Control Panel and then the icon Programs and Features (aka Software in earlier
Windows versions).

3. In the list of Installed Programs select the item HM WebCopy and click the button Uninstall
(aka button Remove in earlier Windows versions).

Assumed that uninstallation with Windows Control Panel is impossible, you can launch the
uninstall program
e Windows XP and previous:
C:\Documents and Settings\All Users\Application Data\HMSE\HM WebCopy\Setup\Unins000.exe
¢ Windows Vista and later:
C:\ProgrambData\HMSE\HM WebCopy\Setup\Unins000.exe

straight from the Windows Explorer by double clicking.

Note: Additionally, some browsers require a manual uninstallation of the HM WebCopy browser
extension in the browser's Add-on manager.

Uninstallation for Additional Users

If you have installed HM WebCopy for additional users, uninstall the user-own configuration data,
program symbols and shortcuts of HM WebCopy for each user as follows:

1. Under Windows NT/2000/XP and all later versions of Window log in with that user account the
user-own uninstallation should be performed for, e.g. a restricted user account.

2. Open the HM WebCopy program group via the Windows Start menu and then click the menu
icon 'Remove HM WebCopy'.

Manual Uninstallation

A manual uninstallation is not recommended. Perform a manual uninstallation
only if the uninstall methods described above are impossible or have failed.
Incorrect modifications of the Windows system registry may cause your system
unstable.

To uninstall HM WebCopy manually you should follow these steps:
1. If you are using Windows NT/2000/XP or a later version of Windows log in as user with
administrative privileges.
2. Delete all files from the home directory of HM WebCopy, usually the folder
C:\Program Files\HM WebCopy and/or C:\Program Files (x86)\HM WebCopy
3. Delete the following folder and all files in it:
> Windows XP and previous:
C:\Documents and Settings\All Users\Application Data\HMSE\HM WebCopy
- Windows Vista and later:
C:\ProgrambData\HMSE\HM WebCopy
4. In the Windows registry delete the following items:
> on a Windows 32-bit:

HKEY_LOCAL_MACHINE\Software\Dipl.-Ing. Martin Haller, Software-Engineering & EDV-Beratung\HM WebCopy
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Uninstal\HMSE_HMWebCopy_is1

> on a Windows 64-bit:

HKEY_LOCAL_MACHINE\Software\Wow6432Node\Dipl.-Ing. Martin Haller, Software-Engineering & EDV-
Beratung\HM WebCopy
HKEY_LOCAL_MACHINE\Software\Wow6432Node\Microsoft\Windows\CurrentVersion\Uninstal\HMSE_HMWebCopy_i

Then perform the following steps once as administrator and once under each additional user
account HM WebCopy was installed to:
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1. Log in under this user account.

2. Delete the program group of HM WebCopy from the Windows Start menu as well as the
shortcuts on the Windows desktop and the Windows Quick Launch bar (if existing).

3. Delete the following folder and all files in it:

o Windows XP and previous:
C:\Documents and Settings\<user>\Local Settings\Application Data\HMSE\HM WebCopy

- Windows Vista and later:
C:\Users\<user>\AppData\Local\HMSE\HM WebCopy

4. In the Windows registry delete the following keys:

HKEY_CURRENT_USER\Software\Dipl.-Ing. Martin Haller, Software-Engineering & EDV-Beratung\HM WebCopy
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\MenuExt\&HM WebCopy...

Manual Uninstallation of Particular Browser Extensions
HM WebCopy Browser Extension for Microsoft Internet Explorer

To uninstall this component manually for a particular user account you should follow these steps:

1. Log in under this user account.

2. In the Windows registry delete the following key:
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\MenuExt\&HM WebCopy...

HM WebCopy Browser Extension for Mozilla Firefox

HM WebCopy (WebExtension) 1.2.0 and later,
HM WebCopy Fx 1.1.1.1 and later:

Note: This browser extension is installed separately for each user account. Hence, you have to
uninstall it separately on each user account too.

To uninstall this component manually for a particular user account you should follow these steps:

1. Log in under this user account.

2. Run Firefox as usual. Administrative privileges are not required.

3. In Firefox open the Add-on manager with the menu command 'Tools > Add-ons'.

4. In the Add-on manager click the extension and then the associated button 'RrRemove' or
'Uninstall’'.

HM WebCopy Fx 1.1.1 and earlier:

Note: This browser extension is installed common to all user accounts of your computer. Hence,
you can't uninstall it for a particular user account only.

To uninstall this component manually for all user accounts together you should follow these steps:

1. Under Windows NT/2000/XP and all later versions of Windows log in as user with
administrative privileges.

2. Run Firefox with administrative privileges. Under Windows Vista and later you have to right
click the Firefox program shortcut thereto and then in the context menu displayed select the
menu command 'Run as administrator'.

3. In Firefox open the Add-on manager with the menu command 'Tools > Add-ons'.

4. In the Add-on manager click the extension and then the associated button 'Remove' or
'Uninstall"'.

Note: If button 'Remove' or 'Uninstall' in the Add-on manager is deactivated, you have not
launched Firefox with administrative privileges.

HM WebCopy Browser Extension for Pale Moon, Basilisk and Waterfox

HM WebCopy (WebExtension) 1.2.0 and later,
HM WebCopy Fx 1.1.1.1 and later:

Uninstallation can be done in the browser's Add-on manager, analogical to Mozilla Firefox (see
above).

HM WebCopy Browser Extension for Chromium-based browsers

HM WebCopy (WebExtension) 1.2.0 and later
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Uninstallation can be done in the browser's Add-on manager, analogical to Mozilla Firefox (see
above).
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Using HM WebCopy il burtii

Overview

How to save a single article

- Removing banner ads (optional)

o Selecting text in the Web browser

o Starting HM WebCopy

> Saving the text with HM WebCopy
How to save an article series
How to configure HM WebCopy

o User defined HTML text

= Placeholders

> Webserver Adjustments
Tips and Tricks

o Tips for selecting text

o Tips for saving the text
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: = HM WebCopy
How To Save A Single Article il @

To save a text area of a Web page (single article) follow these steps:
Remove all banner ads withing the text area you want to save (optional).
In the Web browser window select the text area you want.

2.
3. Then, start HM WebCopy.

4. With HM WebCopy save the text to a file on your computer.
Not

1.

e:
If you want to save not only a single text but multiple texts belonging together from Web pages
you display in turn (article series) you have to pay attention to some peculiarities.
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Removing Banner Ads et

It occurs sometimes that the text area you want to save encloses banner ads. As you can select
just a single cohering text area in the browser window for saving, nothing else remains to be done
as either to select the desired text area together with the enclosed banner ads or to remove the
enclosed banner ads manually before selecting.

Removing banner ads manually
To remove undesirable banner ads before saving the the wanted text area follow these steps:

1. In the browser window use the mouse to select the undesirable advertising.
2. Right-click the selection to popup the browser's context menu.

3. In the context menu displayed choose the menu command '"HM WebCopy'.
4. Depending on your Web browser:

o Internet Explorer:
In the Internet Explorer a small dialog window is displayed showing the available HM
WebCopy actions. Select the option 'Remove selection' and click OK.

o Mozilla Firefox:
In the Firefox browser a submenu is displayed showing the available HM WebCopy
actions. Select the submenu command 'Remove selection’'.

Notes:
e Using the instructions described above you can not only remove banner ads but also
undesirable images and text passages.

e Of course, manually removing banner ads is necessary only if the banner ads are enclosed
within the text area you want to save.

e Some Web pages do not allow selecting a text area. In these cases manually removing banner
ads is not possible.

After you have prepared adequately the wanted text area in the browser window using the
instructions described above, the next step is to select the wanted text area for saving.
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Selecting Text in the Browser HM “ﬁt;ff’g @

Use the mouse to select a text area in the browser window. If necessary, you first have to
prepare the text area you want to save, e.g. removing undesirable banner ads.

Selecting text - Method 1

Click with the left mouse button to the beginning of the text area you want to select. Keep the left
mouse button pressed and drag the mouse pointer to the end of the text area you want to select.
There, let the mouse button go.

If you want to select a huge text area which goes beyond the visible area of the browser window,
follow the steps described above. If the mouse pointer has reached the bottom of the browser
window drag the mouse pointer a little further below (on the status bar or the border of the
browser window). The browser window automatically starts scrolling the text area to let you go on
selecting.

Tip:
@ You can speed up the scrolling of the text area by little movements of the mouse pointer (at
the bottom border of the browser window).

Selecting text - Method 2

Click with the left mouse button to the beginning of the text area you want to select. Release the
mouse button. Go to the end of the text area you want to select. Doing this, you have to scroll the
browser window, if necessary. There, press the Shift key and hold it pressed. Then click with the
left mouse button to the end of the text area you want to select while still pressing the Shift key.
After this let all keys go.

Extending/reducing a text selection

If you have already selected a text area as described above, you can extend the selection with the
text area directly following.

For it, press the Shift key and hold it pressed. Then click with the left mouse button to the end of
the additional text area you want to select while still pressing the Shift key. After this let all keys

go.

Reducing an existing text selection is analogous.

Notes:

e You can select a coherent text area only.

e Some Web pages do not allow selecting a text area. In these cases you just have the chance
to select the whole Web page (if possible) or to save the whole Web page using the menu
commands of your browser.

o It is easy to select the whole text of a Web page by using the browsers menu command 'Edit
> Select AIl' (shortcut: Ctrl+A).

After you have selected the text area you want, start HM WebCopy to save the selected text.
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Starting HM WebCopy HM "{,fr?;; X

After you have selected the text area you want in the browser window, start HM WebCopy to
save the selected text.

To start HM WebCopy there are two methods:

Method 1: Using the context menu of the browser

For this, right click in the browser window the selected text area to display the context menu of
the browser. Alternatively, you can use the shortcut Shift+F10 instead.

Then choose the menu item 'HM WebCopy' in the browser's context menu. This menu item is
implemented browser-specific:

e Internet Explorer:
In the Internet Explorer a small dialog window is displayed showing the available HM
WebCopy actions. Select the option 'Save selection' and click OK.

e Mozilla Firefox:
In the Firefox browser a submenu is displayed showing the available HM WebCopy actions.
Select the submenu command 'Save selection’'.

The action 'Save selection' copies the selected text to the windows clipboard and starts HM
WebCopy.

IMPORTANT: Absolutely pay attention to not clicking outside the selected text. For, that way the
text selection would be canceled.

Note: Some Web pages prevent the browser from displaying the context menu or they display an
individual context menu which does not contain the menu item for HM WebCopy. In these cases
use method 2.

Method 2: Using the Windows Start menu

For this method first copy the selected text in the browser window to the Windows clipboard. To
do this use the browsers menu command 'Edit > Copy' (or shortcut: Ctr/+C).

Then open the HM WebCopy program group via the Windows Start menu and the Programs
menu. At last click on the HM WebCopy menu item to start the program.

Note: To start HM WebCopy as quick and easy as possible for this method, it is recommended to
create a link to the HM WebCopy menu item on the desktop and/or the Windows Quick Launch
bar.
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Saving the HTML Text et B

The saving of the HTML text with HM WebCopy is very easy and quick. On starting HM WebCopy
the HTML text to save is taken from the Web browser window into HM WebCopy and then the
Main Window is displayed.

To save the HTML text click the button 'Save As' and then, in the 'Save As' dialog, enter the
target folder and filename for the HTML file to save. After saving the file successfully the
application window of HM WebCopy will be closed automatically.

Optionally before saving the file, in the Main Window of HM WebCopy you can enter or edit the
title of the HTML text as well as the user defined HTML text which will be inserted into the HTML
text to save.
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How To Save An Article Series HM “ﬁt;ff’g @

To save multiple texts of Web pages belonging together (article series) follow these steps:

e Display the Web pages in your browser one after the other.

e When doing it save the interesting part of each Web page as single article using HM
WebCopy.

e When saving a single article pay attention to
> save all articles into the same target folder and
> leave the filenames suggested by HM WebCopy unchanged.
This way it is guaranteed that references (hyperlinks) possibly contained in the HTML texts will still

work after saving. HM WebCopy maps the concerned hyperlinks to local folder paths and the
suggested filenames.

HM WebCopy BENUTZERHANDBUCH Seite 22 von 62



How To Configure HM WebCopy il burtii

Program Options

To adjust HM WebCopy to your personal preferences, open the 'Options' dialog where you will
find several tabs with all configuration options HM WebCopy offers.

Enter the program options suitable for most of your future application cases. A description of the
several program options you will find in the Help on the 'Options' dialog. The option values are
stored permanently and will be used for all future program starts until they are changed by you
next time.

Main Window

In the Main Window of HM WebCopy you can configure the current saving action by changing the
main windows dialog items.

These adjustments are temporary and valid for the current saving action only.

What would you like to do?

P Change the preferences for the next display of the main window.
P Change the user defined '"HTML text to insert' (placeholders).

P Change HM WebCopy's text processing of the HTML text to save.
» Configure HM WebCopy for new webserver extensions.

P Change the default name of the HTML file to save.

P Change the default target folder of the HTML file to save.
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User defined HTML text et @

You can configure HM WebCopy to insert a user defined HTML text containing context information
(references, saving date) at the beginning or end of the HTML text to save.

You define the HTML text to insert in the input field '"HTML text to insert' of the Main Window.
This input field is visible in the Enlarged View only. Pay attention to enter only well formed HTML
into this input field. Otherwise, an error may occur when later saving the HTML text.

If you will not let insert an user defined HTML text, just remove all of the text in the input field
'HTML text to insert'.

The dialog item 'Insert HTML text at' controls, if the text is inserted at the beginning or end of
the HTML text to save. This input field is visible in the Enlarged View only.

Use the checkboxes '"HM WebCopy Note’', 'Source URL' and 'Current Date' to insert predefined
placeholders into or remove them from the input field "HTML text to insert', quick and easy.
Later when saving the HTML text, the placeholders will be replaced by HTML text according to
their meanings. More detailed information on placeholders you will find here.

Note:
In the 'Options' dialog you can define suitable default values for all dialog items concerning the
user defined HTML text.
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In the input field 'HTML text to insert' of the Main Window of HM WebCopy you can enter an user
defined HTML text, which will be inserted at the beginning or end of the HTML text to save. The
user defined HTML text can contain so-called placeholders.

Placeholders

A placeholder is a string in form of a HTML source text comment with a special meaning defined
by HM WebCopy. At the moment HM WebCopy recognizes the following placeholders:

Placeholder Meaning
<!--%HMWCNOTE%--> HM WebCopy Note: indicates that this HTML text was saved by HM WebCopy.
<!--%SOURCEURL%--> Source URL: gives the URL of the Web page which the HTML text was copied from.
<!--%CURRDATE%--> Current Date: gives the date the HTML text was saved.

Note: If you edit a placeholder manually, pay attention the HTML comment within the angle
brackets of the placeholder may not contain space characters.

Each placeholder has assigned a checkbox of the same name in the main window which can be
used to insert or remove the placeholder in the input field 'HTML text to insert', quick and easy.
When inserting a placeholder into the input field 'HTML text to insert’, HM WebCopy puts each
placeholder in a single line for better view. It makes no difference if multiple placeholders are
placed in a common line or each placeholder has a single line of its own right below.

The HTML text by which a placeholder is replaced on saving can be configured in the 'Options'
dialog.

Placeholder groups

Each sequence of placeholders immediately following one another (in a common line or in multiple
lines right below) constitute an invisible placeholder group. Thus, a placeholder group can
include a single placeholder or multiple ones. Placeholders can be grouped in multiple placeholder
groups. A placeholder group can be at each position in the HTML text of the input field 'HTML text
to insert' where a HTML block element could be too.

When saving the HTML text, additional text will be inserted at the beginning and end of each
placeholder group. This additional text can be configured in the 'Options' dialog. This way, the
placeholders can be embedded into more complexe HTML structures (tables, lists).

When inserting a placeholder via its checkbox HM WebCopy tries to hold together the
placeholders in one placeholder group if possible. The first placeholder is inserted at the beginning
or end of the input field, depending on the current value of the input field 'Insert HTML text at'.
The next placeholders will be added to the existing placeholder groups. The insertion order of the
placeholders within a placeholder group can be configured in any order in the 'Options' dialog.
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There are several systems and script languages to implement Web pages on a webserver, e.g.
HTML, ASP, PHP. On loading such Web pages the webserver converts them into HTML and sends
them as HTML Web page to the Web browser. However the hyperlinks in the received HTML Web
page contain the webserver specific file extensions (e.g. '.php').

HM WebCopy maps the webserver specific file extensions to the HTML file extension. The
Webserver File Extension List of the program options defines which webserver specific file
extensions are known and should be mapped by HM WebCopy.

If there are new systems to implement Web pages on a webserver in the future, introducing new
file extensions, you should add the new file extensions to the Webserver File Extension List in
the program options.

HM WebCopy BENUTZERHANDBUCH Seite 26 von 62



{ _ HM WebCopy
Tips and Tricks Vers, 1.2 @

Overview

¢ Tips for selecting text

o How to select a text area of a Web page

o Put the beginning and end of the selection precisely

o Reverse the selection direction

> How to select the whole Web page

o If a Web page denies generally the selection of text
e Tips for saving the text

- If the browser doesn't display the context menu

o If the 'Save As' button of HM WebCopy is disabled

o If IE fails to save a whole Web page

- If the document saved with HM WebCopy is badly formatted
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Here you will find tips how to select the desired text area in the Web browser, quick and easy.

&

'Y

How to select a text area of a Web page

A detailed description, how to select a text area of a Web page in the browser window, you
will find in the chapter 'Selecting Text in the Browser'

Put the beginning and end of the selection precisely

Try to put the beginning and end of the selection as close as possible to the text area you
want. Sometimes already minimal deviation may result in the additional selection of undesired
text areas.

@ Reverse the selection direction

Sometimes it is better and easier not to select the desired text area from top to bottom but
from bottom to top instead.

@ How to select the whole Web page

For that, use the browser menu command 'Edit > Select All' (shortcut: Ctrl+A). Usually the
shortcut works even if the browser window doesn't have a menu bar.

@ If a Web page denies generally the selection of text

Some Web pages deny generally via Javascript the selection of text.

In such cases you can try to save the whole Web page with HM WebCopy. For that, select
the whole Web page in the browser and save it to a local file using HM WebCopy as usual.
Thereby pay attention to have checked the option 'Remove Scripts and Applets’' on the
'HTML Text Processing' Options tab in the options of HM WebCopy. Later then, open offline
the saved Web page with the browser, select the desired text area and copy it to a second
local file using HM WebCopy. Thereafter you just can delete the original file.
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Here you will find tips for saving the selected text area.

&

'Y

If the browser doesn't display the context menu

Some Web pages block the display of the browser's context menu so that the menu command
for starting HM WebCopy is not available.

In such cases first you have to copy the selected text in the browser to the Windows clipboard
with the browser menu command 'Edit > Copy' and then start HM WebCopy using the
Windows Start menu.

For such cases it is useful to create a shortcut icon to HM WebCopy on the Windows Quick
Launch bar and/or the Windows desktop.

@ If the 'Save As' button of HM WebCopy is disabled

This means that on starting of HM WebCopy either the data transfer of the selected HTML
text from the browser window has failed or the subsequent analysis of the received HTML
text.

In this case you can just cancel the program. But first still wait a little if you had selected a
large text area. The analysis of the HTML text may not have been finished. The button will not
be enabled before that.

Repeat the whole saving process and thereby select a slightly different text area if possible. If
this saving process fails too, try to save the whole Web page, either using HM WebCopy or
the browser functionality. Later then, open offline the saved Web page with the browser and
try again to copy the desired text area to a second local file using HM WebCopy.

‘@ If IE fails to save a whole Web page

Sometimes Internet Explorer fails to save a whole Web page. Internet Explorer aborts the
saving process and displays an error message.

In such cases you can try to save the whole Web page with HM WebCopy. For that, select
the whole Web page in the browser and save it to a local file using HM WebCopy as usual.

If the document saved with HM WebCopy is badly formatted

)

This may happen if the original CSS formatting of the saved Web page is nested very
complexly. Then some CSS formatting may not be applied (correctly) to the saved partial
document structur of the Web page.

In such cases you can try to obtain a better result by choosing another formatting. For that,
repeat the whole saving process thereby choosing another formatting in the dialog item
'Formatting (Stylesheets)' in the main window of HM WebCopy. Try out the offered
formattings subsequently in the following order: Original formatting, Minimal formatting,
Default formatting.
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User Interface of HM WebCopy

Overview

¢ Main Window

o Reduced View (less)

o Enlarged View (more)

o System Menu
Options Dialog

> Tab 'Initial View'

o Tab 'Placeholders’

o Tab 'HTML Text Processing'

o Tab 'Save HTML File'

o Tab 'Others'
User Input Dialog 'Source URL'
About Dialog
'License Activation' Dialog
Shortcuts of HM WebCopy
Getting Help on HM WebCopy
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On starting, HM WebCopy first gets the text selection from the Web browser window and
analyzes it. Note: Thereby it may come to slight delays, if the text selection is very huge.

Then, the main window is displayed. The input field 'HTML document title' shows the title of the
analyzed HTML text. The other input fields and dialog items are pre-configured with the default
values from the 'Initial View' program options.

The main window offers two views which can be toggled with the button 'More' or 'Less’,
respectively. The Enlarged View offers additional input possibilities for the user defined HTML text
to insert. The Reduced View shows only the most important dialog items for the user defined
HTML text to insert.

Dialog Items

A detailed description of the dialog items in the main window you will find in the help on the
respective view.

» Reduced View
» Enlarged View

Buttons and Menu commands

Use the button 'Save As' to open the 'Save As' dialog in which you can save the selected HTML
text to a local HTML file on your computer. This button is disabled if the text selection in the Web
browser window does not contain valid HTML text or if an error occured when transferring the text
selection from the browser window to HM WebCopy.

Use the button 'Options' to open the 'Options' dialog in which you can adjust the program
configuration to your needs.

Use the button 'Cancel’ to close the main window without saving the HTML text.
Use the button 'Help' to display help on HM WebCopy.

Use the button 'About’' (or alternatively the System menu) to open the 'About' dialog which
displays the program version and the copyright, license and support information as well.
Furthermore this dialog box has a button to open the 'License Activation' dialog in which you can
enter your license information to activate the unregistered shareware version.
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The Reduced View of the Main Window shows only the most important dialog items available to
change the user defined HTML text to insert. The other dialog items are usually configured right by
the program options and need not be changed each time.

Dialog Items

HTML document title Title of the HTML document. The default value is taken from the selected HTML text. You
can enter any text but no HTML text.

Formatting (Stylesheets) Using this dialog item you specify how the HTML text to save should be formatted by CSS
stylesheets:

e Original formatting: With this option the formattings (CSS stylesheets) of the
source document are used as far as possible.

e Minimal formatting: With this option all formattings (CSS stylesheets) of the
source document are removed and just minimal styles are added for formatting the
font family and size. The brower's default styles are applied to all other formatting
options.

o Default formatting: With this option all formattings (CSS stylesheets) of the source
document are removed. Thus, the saved HTML text will be displayed with the default
formatting styles of your browser.

HM WebCopy Note If this checkbox is checked, the placeholder <1--%%HMWCNOTE%--> is inserted into the
input field '"HTML text to insert' which will be replaced later, when saving the HTML
text, by a notice that this HTML document was saved using HM WebCopy. More
information on placeholders you will find here.

Source URL If this checkbox is checked, the placeholder <!--%SOURCEURL%--> is inserted into the
input field '"HTML text to insert' which will be replaced later, when saving the HTML
text, by a link to the original HTML file from which the HTML text was copied. More
information on placeholders you will find here.

Tagesdatum If this checkbox is checked, the placeholder <!--% CURRDATE%--> is inserted into the
input field '"HTML text to insert' which will be replaced later, when saving the HTML
text, by the current date so that the date of saving the HTML text is recorded. More
information on placeholders you will find here.

More >> Use this button to switch to the Enlarged View of the main window.

After saving the HTML If this checkbox is checked the corresponding action is performed. Which browser to use
document open it in a new for displaying the HTML file can be defined in the program options.
browser window

Note: For a description of the other dialog items of the main window see the help on the
Enlarged View. For a description of the push buttons and menu commands of the main window
see the help on the Main Window.
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In the Enlarged View of the Main Window all dialog items of the main window are visible.

You can define suitable default values for all dialog items of the main window (except for the input
field '"HTML document title") in the program options.

Dialog Items

HTML document title For a description of this dialog item see the help on the Reduced View.

Formatting (Stylesheets) For a description of this dialog item see the help on the Reduced View.

HM WebCopy Note For a description of this dialog item see the help on the Reduced View.

Source URL For a description of this dialog item see the help on the Reduced View.

Current Date For a description of this dialog item see the help on the Reduced View.

<< Less Use this button to switch to the Reduced View of the main window.

HTML text to insert Optional user defined HTML text inserted at the beginning or end of the HTML document

to save. Use this input field to define context information (references, saving date) to
save together with the HTML document.
You can either leave this input field empty or enter HTML text. Moreover, by checking
the checkboxes 'HM WebCopy Note', 'Source URL' and 'Current Date' you can insert so
called placeholders into this input field which are replaced by appropriate HTML text
later, when saving the HTML document.

Note: Pay attention to enter only well formed HTML into this input field. Otherwise, an
error may occur when later saving the HTML text.

Insert HTML text at Using this dialog item you determine if the user defined 'HTML text to insert' is
inserted at the beginning or end of the HTML text to save.

Moreover this dialog item controls if the placeholders are inserted at the beginning or
at the end of the input field "HTML text to insert’, if possible.

After saving the HTML For a description of this dialog item see the help on the Reduced View.
document open it in a new
browser window

Note: For a description of the push buttons and menu commands of the main window see the
help on the Main Window.
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The title bar is located along the top of a window.

k' HM WebCopy

The title bar of the main window shows the name of the application, whereas the title bar of dialog
windows shows the name of the dialog function.

Drag the title bar to move the window.

Note: You can also move dialog windows by dragging their title bar.

The title bar of the main window contains the following dialog elements:

e Application Control menu box (System menu)
¢ Name of the application

e What's This Help button

¢ Close button

Note: The buttons of the title bar correspond with the same commands in the System menu.

The title bar of a dialog window contains the following dialog elements:

e Name of the window
¢ What's This Help button
¢ Close button
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The System menu (Control menu) of the main window offers the following commands:

Restore Restores normal size and position of the window.
Move Moves the window (with arrow keys).
Size Changes the size of the window (with arrow keys).
Minimize Reduces the window to an icon.
Maximize Enlarges the window to full size.
Close Closes the window.

About ... Opens the 'About' dialog of the program.

Shortcuts

Keys: Alt + Spacebar
Mouse: Click on the top left edge in the title bar of the main window.

HTML docume
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Use the Options (preferences) to configure the program and adjust it to your requirements.

Click on the several tabs (option groups) and change the options you want. Tab 'Initial View'
contains options to configure the initial view of the applications main window. Tab 'Placeholder’
contains options to configure the user defined 'HTML text to insert'. Tab 'HTML Text Processing'
contains options to control the processing of the links in the copied HTML text. Tab 'Save HTML
File' contains options to configure the saving of the copied HTML text to your computer. Tab
'Others' contains other options to configure the application.

Buttons
Use button 'OK' to save all your changes and close the dialog box.

Use button 'Cancel' to close the dialog box without saving the changes you have made since
opening the dialog box or the last saving of the options.

Use button '"Help' to display help on this dialog box.

Envoking

Open this dialog box with the button 'Options’ in the Main Window of the application.
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This tab of the 'Options' dialog contains options you can use to control the initial view of the
main window after starting the program. Changes to options on this page will not take effect

'Initial View' Options

until the program is restartet.

Dialog Items

Initial size of the main
window

Formatting

HM WebCopy Note
Source URL
Current Date

HTML text to insert

Insert HTML text at

After saving the HTML
document open it in a
new browser window

Filename of your favorite
browser

HM WebCopy

Reduced View: The input field HTML text to insert is NOT visible at the first display of
the Main Window.

Enlarged View: The input field HTML text to insert is visible at the first display of the
Main Window.

Default value for the dialog item of the same name in the Main Window. See there for a
description.

Default value for the checkbox of the same name in the Main Window. See there for a

description.

Default value for the checkbox of the same name in the Main Window. See there for a

description.

Default value for the checkbox of the same name in the Main Window. See there for a

description.

Default value for the checkbox of the same name in the Main Window. See there for a

description.

You can either leave this input field empty or enter HTML text. Moreover, by checking
the checkboxes HM WebCopy Note, Source URL and Current Date you can insert so called
placeholders into this input field which are replaced by appropriate HTML text when
saving the HTML document.

Default value for the dialog item of the same name in the Main Window. See there for a
description.

Default value for the checkbox of the same name in the Main Window. See there for a
description.

If this checkbox is checked, the dependend input field for the favorite browser is enabled,
otherwise disabled.

Enter the filename of the EXE file of your favorite Web browser you want to use to open
and show the saved HTML document. If this input field is empty the default browser for
displaying HTML files will be used as defined in your system.

Sometimes just the filename may not be enough to locate your browser. In this case
enter the full folder path and filename of the browsers EXE file.

BENUTZERHANDBUCH

Seite 37 von 62



' ' . HM WebCopy
Placeholder’ Options et @

To change the options on this tab a good knowledge of HTML is necessary. If you
& have no knowledge of HTML leave the options unchanged. Use the button 'Reset’
to restore the HTML text originally contained in the input fields.
This tab of the 'Options' dialog contains options to define the placeholders used in HTML text to
insert. Changes to options on this page will take effect immediately after closing the dialog box.

Pay attention to enter only valid HTML text into the input fields. Your inputs are not verified,
neither syntactically nor semantically. The placeholder group context together with the
enclosed placeholder context have to be a valid HTML text fragment.

Dialog Items

Insertion Order of Use this dialog item to define the placeholders insertion order which is used in the Main
Placeholders Window and in the 'Initial View' options tab when clicking on the placeholder checkboxes to
insert a placeholder into the input field HTML text to insert.

1 = placeholder HM WebCopy Note
2 = placeholder Source URL
3 = placeholder Current Date

For example, the insertion order 2 1 3 means that the placeholders are inserted into the
input field HTML text to insert in the following order:

<!--%SOURCEURL%-->
<!--%HMWCNOTE%-->
<!--%CURRDATE%-->

Reset Use this button to reset all other dialog items of this options tab to a defined initial state.
This way you achieve that all HTML context input fields contain well formed HTML text
again which arranges the placeholders within a table one beneath the other.

HTML text to insert In this input field you can enter the HTML text to insert into the HTML document to save
BEFORE a Placeholder before each placeholder group.
group A placeholder group consists of a single placeholder or multiple placeholders arranged

immediately one beneath the other, in the input field HTML text to insert.

HTML text to insert In this input field you can enter the HTML text to insert into the HTML document to save
AFTER a Placeholder after each placeholder group.

group

Placeholder Use this dialog item to select the placeholder which placeholder context you want to display

and edit in the following input fields.

HTML text to insert In this input field you can enter the HTML text to insert into the HTML document to save
BEFORE the selected before the placeholder selected in the combobox Placeholder.
Placeholder

HTML text to insert In this input field you can enter the HTML text to insert into the HTML document to save
AFTER the selected after the placeholder selected in the combobox Placeholder.
Placeholder
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This tab of the 'Options' dialog contains options you can use to control the text processing of
the resources and hyperlinks in the HTML text to save. Changes to options on this page will

take effect immediately after closing the dialog box.

Dialog Items

Remove Scripts
and Applets

Remove
References to
Multimedia
Resources

Default HTML File
Extension

Default HTML
Filename

Webserver File
Extensions

HM WebCopy

If this checkbox is checked scripts and applets are removed from the HTML text when saving the
HTML document as well as references to external scripts and applets. This concerns JavaScript, VB
Script and JavaApplets. If this checkbox is unchecked scripts and applets remain in the HTML
document and are saved locally if necessary.

Usually scripts and applets are not required to display a HTML text. Mostly they serve for
navigating a Web page or implementing dynamic behaviour. Poor scripts may even prevent the
saved HTML document to be displayed properly because the folder paths on the local computer
differs from the ones on the webserver. Moreover scripts are a potential security problem.

Therefore it is strongly recommended to check this option. You should uncheck this
option only if you have deactivated execution of active elements (JavaScript, ...) in your
Web browser.

If this checkbox is checked links to multimedia resources are removed from the HTML text when
saving the HTML document. This concerns references to sound and video files. If this checkbox is
unchecked links to multimedia resources remain in the HTML document and the linked resource
files are saved locally.

Usually multimedia resources are not required to display a HTML text. Due to the size of such files
they just waste your download time and local disk storage.

Therefore it is recommended to check this option.

In this input field you have to enter the default HTML file extension (with a leading dot, e.g.
'.htm") you want to use to save HTML documents on your computer.
The default HTML file extension has two meanings:
1. Itis used if a link to map contains a filename with a webserver file extension (e.g. '.asp'). The
web server file extension is replaced by the default HTML file extension.

2. It is used if you enter a filename without file extension for the HTML file to save. In this case
the default HTML file extension is added to the filename.

In this input field you have to enter the default HTML filename (without a folder path but with a
file extension, e.g. 'index.htm'). The file extension should match the default HTML file extension.

The default HTML filename is used if a link to map has no filename. Such links usually refers to
an index HTML file.

In this input field you have to enter a comma separated list of webserver file extensions, e.g.
' *htm*,.asp*,.php*'. The file extensions specified in the list have to start with a dot and may
contain the character * (wildcard) at the beginning and/or at the end which represents any
sequence of any characters, e.g. ".php*'.

Only the webserver file extensions named in this list are replaced by the default HTML file
extension when mapping the links in the HTML document.

BENUTZERHANDBUCH

Seite 39 von 62



HM WebCopy

'Save HTML File' Options Vers, 1.2

9

This tab of the 'Options' dialog contains options you can use to configure the saving of the HTML

file. Changes to options on this page will take effect immediately after closing the dialog box.

Dialog Items

Remember last target folder
used for saving the HTML file

Always use this target folder
for saving the HTML file

Folder Path

Button ...’
(choose a folder)

Character Encoding

Don't display each error
message separately when
saving the resources of the
HTML file

HM WebCopy

If this option is checked the last target folder used for saving a HTML file is
remembered and will be suggested as default when saving the next HTML document.

If this option is active the dialog items 'Folder Path' and button '..." are are
disabled.

If this option is checked the folder contained in the input field 'Folder Path'
underneath will be suggested as default when saving the next HTML document.

If this option is active the dialog items 'Folder Path' and button '..." are are
enabled.

If the option 'Always use this target folder for saving the HTML file' is selected
you have to enter a valid folder path into this input field or select one using the
button '...".

If the option 'Always use this target folder for saving the HTML file' is selected
you can use this button to choose a valid folder path for the input field 'Folder
Path'.

Use this combobox to configure the character encoding of the HTML text in a saved
HTML file.

e ANSI: This option uses the default Windows ANSI code page for character
encoding which depends on your current regional language settings, e.g.
Windows-1252 in Western Europe and North America. See the Region and
Language Options in the Windows Control Panel.

¢ Unicode: This option uses Unicode UCS-2 (little endian) for character encoding,
the default Unicode encoding in Windows.

e Unicode (UTF-8): This option uses Unicode UTF-8 for character encoding, a
special Unicode encoding with minimum space requirements.

If this checkbox is checked an error message is not displayed for each error occured
when saving the resources of a HTML file. Instead, a single summary error message
is displayed at the end of the saving action.

If this checkbox is unchecked a detailed error message is displayed for each error
occured when saving the resources of a HTML file.
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This tab of the 'Options' dialog contains other options to configure the applications behaviour.
Changes to options on this page will take effect immediately after closing the dialog box.

Dialog Items

Auto-display of If this checkbox is checked a context help popup window (small tip window) is displayed

context help automatically if you position the mouse pointer over a dialog item.
POpUp Windows ¢ his checkbox is unchecked the context help popup windows are not displayed automatically. But
(tips) you can display them, if needed, using the shortcut Shift+F1. In chapter 'Getting Help' you will find

further ways to display context help or more detailed help.

Language Language for the user interface of the application.

The dropdown list contains only those languages which were selected during installation of the
application. The language 'English' is always available. Other languages are optional. If you need an
additional language, run once again the setup program of the application, if necessary, and install
the additional language package (see Maintenance Installation). At the Product Homepage of the
application you may find additional language packages for downloading.
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This dialog box is displayed in rare cases only, that is if HM WebCopy has not got the source URL
when taking the selected text area from the Web browser.

The source URL is absolutely necessary for HM WebCopy to be able to copy the resources
required to display the HTML text to save.

Now you have the following possibilities: Either you enter the source URL manually as described in
the dialog box, or you cancel the whole saving action and repeat it.

Manual Input of the Source URL

Always enter the full source URL, so starting with the Internet protocol. You can see the full source
URL in the address bar of your browser.

To enter the source URL quick and easy copy the completely selected URL in the address bar

@ of your browser using the menu command 'Edit > Copy' (shortcut: Ctrl+C) and paste it into
the edit field Full URL of the dialog box using the context menu command 'Paste’' (shortcut:
Ctrl+V). If necessary, you still have to add the Internet protocol 'file://'.

Abort and Repetition of the Saving Action

To do this click the button 'Cancel' in the dialog box, then confirm the displayed abort message
and quit HM WebCopy.

Afterwards switch to the Web browser window. Renew the text selection you want and repeat the
saving with HM WebCopy. Usually it works without problems at the second time. Sometimes it
helps to select not exactly the same text area but a little larger or smaller one.
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This dialog shows the exact version number of the program, as well as copyright, license and
support information.

Buttons
The button 'Close' closes the dialog window.

The button 'License' opens the 'License Activation' dialog where you can enter your license
information to activate the unregistered shareware version. Note: If the application need not to be
activated, this button does not exist.

Envoking

Open this dialog window with the menu command 'Help » About' in the main window of the
application. If there is no menu bar in the main window, use the system menu command 'System
menu » About' instead.
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In this dialog you can enter the license information you have got from the licenser to activate the
unregistered shareware version of the program. The activation of the program is done by
activating the entered license. Thereby the license will be verified. Note: You can repeat the
activation of a license as often as you want.

A license consists of two parts: the license number (also called activation code) and the
appropriate license file. You receive both parts from the licenser with a license letter (in written
form or by email). Save the license file to the program folder of the application. Alternatively, you
can save it to any other folder on your computer (e.g. on a removable disk).

Dialog Elements

Enter all data exactly the same as specified in the license you have received from the licenser.
Note that the values are case-sensitive and pay attention to the difference between the
digit 0 (zero) and the uppercase letter O as well as the digit 1 and the uppercase letter
1. The license number does not contain lowercase letters.

License number: The activation code you have got from the licenser.

License file: Full path and filename of the license file you have got from the licenser.

Dongle Port: Locigal interface name in the Windows operating system which the dongle is connected
(optional) to. If a 'bound volume' is used as dongle, this is the drive letter of the drive containing

the 'bound volume' followed by a colon (:).
Note: This input field is enabled only if the license is proteced by a dongle.

Dongle Description: Name / description of your choice of the dongle ('‘bound volume'). It is used in
(optional) messages and may not be empty.
Note: This input field is enabled only if the license is proteced by a dongle.

Buttons

The button '..." opens a dialog window to choose the license file to activate.

The button 'Activate' starts the activation process for the license you have entered.
The button 'Help' displays help on dialog window.

The button 'Close' closes the dialog window.

Envoking
Open this dialog window with the button 'License’' in the 'About’ dialog.

Due to Windows security restrictions administrative privileges are needed to activate a license. If
the following message is displayed when opening the dialog window, you are currently not
authorized to it and all input fields as well as the button 'Activate' are disabled.

=3

i 0 \ The program has currently ne access rights to modify or activate a
@' license. To gain these rights you have to log on to Windows with an
administrator account and run the program with administrative
privileges (click ‘Help' for more information].

0K ||  Help

To gain the rights needed you have to log on to your Computer with an administrator account and
run the application with administrative privileges:

To find out which user account of your computer is an administrator account, open User
Accounts in Windows Control Panel. Then if needed, restart your computer and log on to
Windows with an administrator account.
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To start a program with administrative privileges in Windows Vista and later right click the
program's shortcut in the program group of the application and then select the context menu

command 'Run as administrator'. In previous Windows versions just click the program's
shortcut.

Note: Starting the application with administrative privileges is only necessary to activate a license
(see Activation). After it, you may restart the program as usual.

HM WebCopy BENUTZERHANDBUCH Seite 45 von 62



Shortcuts

Use shortcuts (also called accelerator

operations.

Common Shortcuts (in all windows)

Window control

Close the application

Close the active window

Help on the active window or the active dialog item

Edit field control

Direct jump to an edit field

Jump to the next edit field

Jump to the previous edit field

To the beginning of the edit field

To the end of the edit field

Undo the input

Combobox control

Open or close the item list

To the next/previous item in the open item list

Take current item of the item list

To the next tab

Tab control

To the previous tab

Checkbox control

Check/uncheck the checkbox

Button control

Press the button

HM WebCopy

Key(s)
Alt+F4 or Esc
Alt+F4 or Esc
F1 or Shift+F1

Key(s)
Alt+letter underlined
TAB
Shift+TAB
Pos1
End
Ctrl+Zz

Key(s)
F4
lort
TAB or Return/Enter

Key(s)
Ctrl+TAB
Shift+Ctrl+TAB

Key(s)
Space

Key(s)
Space

BENUTZERHANDBUCH

HM WebCopy

Vers, 1.2 I@

keys) to gain quick access to often used commands or
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Getting Help HM “{:‘:ﬁ"{; @

HM WebCopy offers you several ways to get help.

The What's This? help shows information on the current dialog item (edit field, combobox,
checkbox, push button, and so on) of a window. The help text is shown in a small popup window
near by the dialog item concerned. The popup window can be displayed automatically (tip
window), or manually if needed.

All other help types are displayed in an own help window which can be enlarged, reduced or
moved in any way.

The context help shows information on the active window and explains possible dependences of
the several dialog items.

The help topics offer an overview and hierarchical outline with all help texts available.

The help index offers the possibility to filter and display the existing help topics using predefined
key words.

The full text search offers the possibility to search the existing help topics for any words.

Use the favorites to collect often used help topics to make them accessible quickly.
Envoking

Help Type Getting help

What's Keys: Shift+F1

This? Help Mouse: With the right mouse button click on the dialog item on which you need help. In the context menu
displayed after that select the menu item What's This?. Note: If the displayed context menu does
not contain a What's This? menu item (e.g. edit fields), right click the label of the dialog item
instead of the dialog item itself.

Depending on the current program configuration (see Other Options) you have additionally the possibility to
let display the What's This' help in an automatically shown tip window. For this, position the mouse pointer
for a moment over the dialog item you need help on.

Context Keys: F1

Help Mouse: Click the push button Help.
Help Keys: Alt+F1
Topics Mouse: n/a
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HM WebCopy

Browser Extensions il

The integration of HM WebCopy into the user interface of the several Web browser programs is
made by browser specific add-ons implemented as browser extensions.

The main task of these add-ons is to provide a menu item in the context menu of the browser if a
text area is selected in the browser window. Via this menu item the functions of HM WebCopy
can be launched directly from the browser window, easy and quick.

The needed browser extensions are selectable components at the installation of HM WebCopy.
But with the installation program (Setup) of HM WebCopy you can perform a separate installation
of a particular browser extension later too.

Actually there are browser extensions for the following Web browsers:

e Microsoft Internet Explorer

e Mozilla Firefox

e Firefox-based Web browsers (Pale Moon, Basilisk, Waterfox)

e Chromium-based Web browsers (Chromium, Google Chrome, Opera, Vivaldi, Iron)

Other Web browsers

You are able to use HM WebCopy with other Web browsers (without browser extension) too,
provided the Web browser offers a feature to copy the selected text area into the Windows
clipboard in HTML format. In this case always start HM WebCopy by Method 2 (Using the
Windows Start menu).

To find out how far your favorite browser complies with the conditions just try it out with any Web
page or a HTML file on your computer. If no error message is displayed on starting HM WebCopy
and the button 'Save As' of HM WebCopy's main window is enabled your browser seems to
comply with the basic assumptions. Click the button 'Save As' and save the selected HTML text to
a local file. Then open the saved HTML file in your Web browser and verify the result.

If the saved HTML text is formatted completely different as the original, your browser does
propably not comply with all conditions, but nonetheless you can use HM WebCopy. Repeat the
whole procedure and before saving in HM WebCopy choose the option 'Minimal formatting' in the
dialog item 'Formatting (Stylesheets)'. With this option you may achieve a better formatting
result.
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Internet Explorer Extension il burtii @

The integration of HM WebCopy into the browser Internet Explorer is made by a browser
extension available for Internet Explorer 5.5 and higher.

The Internet Explorer browser extension adds the menu item 'HM WebCopy' to the selection
context menu of the browser which opens a small dialog window showing the available functions
of HM WebCopy:

e Action 'Save selection':

This function hands over the selected text of the browser window to HM WebCopy. This
corresponds to Method 1 for starting HM WebCopy.

Note: Alternatively, with Internet Explorer you can use Method 2 for starting HM WebCopy (using the Windows Start
menu) without drawbacks.

e Action '"Remove selection':

This function removes the selected text in the browser window. You can use it to prepare the
text area in the browser window you want to save.
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Firefox Extension Vers, 1.2 |

The integration of HM WebCopy into the Mozilla Firefox browser is made by two different
browser extensions, dependent on the browser's version:

e HM WebCopy Fx, file 'hmwcfx.xpi': as of Firefox 1.5 to Firefox 51.

¢ HM WebCopy (WebExtension), file 'hmwcwe.xpi': as of Firefox 52.
Both browser extensions add the submenu '"HM WebCopy' to the selection context menu of the
browser which contains two menu items:

e Menu item 'Save selection’:

This menu item hands over the selected text of the browser window to HM WebCopy. This
corresponds to Method 1 for starting HM WebCopy.

Note: Method 2 for starting HM WebCopy (using the Windows Start menu) should be used with Firefox just in
exceptional cases because this starting method may loose formatting information.

e Menu item 'Remove selection':

This menu item removes the selected text in the browser window. You can use this function to
prepare the text area in the browser window you want to save.
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Extension for Firefox-based Browsers M vf,?"“f !

Pale Moon

The integration of HM WebCopy into the Pale Moon browser is made by the HM WebCopy Fx
extension for Firefox.

As Pale Moon is a fork of Firefox 24 this Firefox browser extension is compatible to Pale Moon
24 and higher. For further details see Firefox Extension.
Basilisk

The integration of HM WebCopy into the Basilisk browser is made by the HM WebCopy
(WebExtension) extension for Firefox.

As Basilisk 4 is a fork of Firefox 55 this Firefox browser extension is compatible to Basilisk 4 and
higher. For further details see Firefox Extension.
Waterfox

The integration of HM WebCopy into the Waterfox browser is made by the HM WebCopy
(WebExtension) extension for Firefox.

As Waterfox is a fork of Firefox this Firefox browser extension is compatible to Waterfox 52 and
higher. For further details see Firefox Extension.
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Extension for Chromium-based Browsers HM “ﬁtﬁ"g @

The integration of HM WebCopy into Chromium-based browsers is made by the HM
WebCopy (WebExtension) browser extension, file 'hmwcwe.crx', which is compatible to the
following Web browsers:

Chromium 59 and later.

Google Chrome 59 and later.

Opera 46 and later.

Vivaldi 1.10 and later.

Iron 59 and later.

The browser extension adds the submenu 'HM WebCopy' to the selection context menu of the
browser which contains two menu items:
¢ Menu item 'Save selection':

This menu item hands over the selected text of the browser window to HM WebCopy. This
corresponds to Method 1 for starting HM WebCopy.

Note: Method 2 for starting HM WebCopy (using the Windows Start menu) should be used with Chromium-based
browsers just in exceptional cases because this starting method may loose formatting information.

e Menu item 'Remove selection':

This menu item removes the selected text in the browser window. You can use this function to
prepare the text area in the browser window you want to save.
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Overview

e Copyright
e License Terms
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Copyright Vers, 1,2 @

This Software product is NOT in the public domain. It is copyrighted by the Author. This Software
and accompanying documentation are protected by Austrian Copyright law and also by
international copyright and treaty provisions.
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License Terms Vers, 1.2 |

On installation of the Software you have read and accepted the terms of the enclosed End User
License Agreement which applies to this Software product.

End User License Agreement

PLEASE READ THIS DOCUMENT CAREFULLY BEFORE INSTALLING THE
SOFTWARE. THIS AGREEMENT LICENSES THE ENCLOSED SOFTWARE

TO YOU AND CONTAINS WARRANTY AND LIABILITY DISCLAIMERS. BY
INSTALLING OR USING THE SOFTWARE, YOU ARE AGREEING TO
BECOME BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO

NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NEITHER
INSTALL NOR USE THE SOFTWARE.

1. Definitions.

(a) The term "Licenser" means "Dipl.-Ing. Martin Haller, Software-
Engineering & EDV-Beratung" and its suppliers.

(b) The term "Software" means the enclosed Licenser's software product
and the related documentation and all related updates.

(c) The term "registration code" in this document means the data
technical representation of a valid license according to point
5 of this agreement, whatever shape it has (activation code,
license number, license file or others).

The unregistered shareware version may be freely distributed, provided that:
e Such distribution includes only the original archive supplied by the Licenser. You may not
alter, delete or add any files in the distribution archive.

e Such distribution contains the same copyright and other proprietary notices pertaining to this
Software that appear in the Software.

e The distribution does neither include a registration code nor methods, programs or instructions
to get or create a registration code or in any other way upgrade the Software from its
unregistered status unlawfully.

¢ No money is charged to the person receiving the Software, beyond reasonable cost of
packaging and other overhead.
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e Order / Payment
e Delivery
e Activation
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Order / Payment Vers, 1.2

Subject of the Contract of Sale

On paying the purchase price (registration fee) you purchase a user license for the full version of
the program. The terms of the enclosed End User License Agreement are effective upon
installation of the software.

Purchase Price / Registration Fee

The price indicated in the various download archives of the Internet is a target price. Dependent
on currency exchange rates and the currentness of the web pages in the download archives the
real price can differ slightly from this target price.

For the currently valid purchase price refer to the Online Product Page =@ in the Share*It!
Online Shop.

Order / Payment

For order and payment of a single user license you can choose between the ways mentioned
below. Each of these ways offer different types of payment. The purchase price is independent of
the type of ordering and payment you select.

If you want to use the program on multiple workstations you should request for information about
the low-cost and easy to handle multi-user licenses. Send your email request directly to the
HMSE Sales.

Companies within the European Union can order tax-free by using their VAT-No.
Order Types
Ordering via Share*It! / Digital River

Sharelt is a world-wide acting software distribution company selling the software of many
software developers as a reseller. Which means, when selecting this way of ordering the contract
of sale is made between you and Sharelt. Likewise, accounting and payment processing is handled
by Sharelt.

Sharelt offers a fast online order and you can order by email, letter, phone or fax too. For
payment you can choose between a multitude of payment types (all possible credit cards,
transfer, check, cash, online payment, PayPal) and currencies.

P Further information on ordering at Sharelt

Ordering Directly at the Software Developer

Residents within the European Community can order directly at the software developer HMSE.
When selecting this way of ordering the contract of sale is made between you and HMSE. In this
case accounting and payment processing is handled by HMSE.

You can order by email, letter, phone or fax. Please note, when using this way of ordering,
accounting and payment processing is possible in Euro solely. You can choose between the
payment types EU standard transfer, collection only check or cash. Payment by credit cards is not
possible.

Note: Companies, organisations and public institutions which are residents within the European
Community and which are only allowed to buy on account due to existing regulations and legal
provisions, should choose this way of ordering.

P Further information on ordering at HMSE
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Order at Sharelt et @

Order Procedure

Detailed information on the order and payment procedure at Sharelt you will find online in the
Sharelt Customer Care Center =+@.

If you have questions beyond or need further information please contact Sharelt directly:
register@shareit.com.

Possible Types of Ordering
43 Online Order via Internet: Online order form =@

Ordering online is the fastest way to order the program and is handled via secure web
pages. All information needed for ordering is available directly in the online order form and
you can choose between different currencies, payment types, and so on.

Alternative to the link above, to display the online order form you can go to www.shareit.com
-+ and enter the Sharelt Program Number into the input field 'searching for programs' at the
bottom left of the screen.

Order by Letter/Fax/Email: Orderform for printing
Fill in the order form completely and send/fax/mail it to:

Sharelt! / Digital River GmbH Phone: +49-221-31088-20

Scheidtweilerstr. 4 Fax: +49-221-31088-29
50933 Koeln Email: register@shareit.com
Germany Internet: www.shareit.com =@

&3 order by Phone: +49-221-31088-20
Employees of the Sharelt call center, Koeln, Germany, will accept your order.

Customers in the United States and Canada may also order by calling the toll-free number
1-800-903-4152 of the US call center of Sharelt around the clock.
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Order at HMSE Vers, 1,2 @
Order Procedure

Due to organizational reasons this way of ordering is possible only for residents
within the European Community.

To order directly at the software developer HMSE send your order by email, letter, phone or fax
to:

Dipl.-Ing. Martin Haller Phone: +43-5372-68504
Software-Engineering & EDV-Beratung Fax: +43-5372-68504
Langkampfner Strasse 19 Email:  see product information
6330 Kufstein / Austria Internet: see product information

Your order should contain the following ordering data:

e Your name, address and email:
Giving a valid email address is absolutely obligatory because the whole order procedure and
delivery will be made by email.

e Your VAT number (only for companies within the EU, if available).

e The payment type you want:
You can choose between the following payment types: EU standard transfer, collection only
check or cash. If you want an other payment type, please select an other order type.

¢ Name and version number of the program:
See the product information for these data.

e The number of licenses you want to order:
You need a license for each computer you want to install and use the program.

e The registration data the license should be made out, once for each license ordered. For
further information see here.

To simplify the procedure you can use the enclosed order form, print it and fill it out.

Order Confirmation

After receipt of your order you will receive an order confirmation by email containing an unique
order number, the total amount to pay as well as further information on the payment type you
have selected (bank infos, and so on).

Payment

Please understand, due to organizational reasons we can accept your payment in Euro only. If you
want to pay in an other currency please select an other order type. Possible exchange and transfer
costs of the payment process are at your expense. To speed up the order processing it is
important to give the order number from the order confirmation you have received as
additional payment information.

Please note, that the contract of sale will not become operative until receipt of payment of the full
total amount indicated in the order confirmation. Payment before delivery is world-wide the
common practice when ordering shareware.

Buy on Account

This order type is intended for companies, organisations and public institutions only which are
residents within the European Community and which are only allowed to buy on account due to
existing regulations and legal provisions.

In this case please transmit your order containing your internal order number and signature and
the other ordering data (see above) in written form by letter or fax. After receipt and verification
of your order you will receive the delivery together with the order confirmation.
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In your order give the following registration data once for each license ordered:

e Username:
First name and last name of the licensee or other name.

¢ Organization (may be empty for privat persons):
Name of organization the licensee belongs to.
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After receipt of your order and payment you will receive your user license by email as soon as
possible (on online ordering usually within 2 days).

The delivery of the user license will take place in form of a license letter containing your license
number (activation code) and instructions how to activate the license and to convert the
shareware version of the program to it's full version. Attached to the license letter you will find
an encrypted license file which is required for the activation.

Additionally, in the next days the vendor will send you an invoice and by cash with order a
confirmation of receipt of payment.

Note:

The program itself (the software) you have already downloaded to your computer, installed and
tested as shareware version. As the shareware version is identical with the full program version,
the software is not delivered once again. On activation of the shareware version all restricted
program features are unlocked so that you can use the full programm unrestrictedly.

If you have not yet installed the shareware version of the program on your computer you can
download it from the Product Homepage or from other shareware web sites.
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Activation HM WebCopy @

Vers, 1.2

To activate a license with the unregistered shareware version of the application:

1.

Under Windows NT/2000/XP and all later versions of Windows log in to your computer with an
administrator account.

Note: To find out which user account of your computer is an administrator account, open User Accounts in Windows
Control Panel. Then if needed, restart your computer and log on to Windows with an administrator account.

First of all make a backup of the license you have received from the licenser. Back up the
license number as well as the license file.

. Then save the license file to the program folder of the application. Alternatively you can save

it to any other folder on your computer.

Note: If you have created several user accounts on your computer and want to use the program under several user
accounts too, do not save the license file to the folder 'My Documents' but to a folder readable by all users. A license
is valid for all user accounts on a computer and is automatically activated for all users.

Open the Windows Start menu and click 'All Programs’, click the program group of the
application and then the program shortcut 'License Activation'.

In the License Activation window click the button 'Start' to open the 'License Activation'
dialog.

In the 'License Activation' dialog enter all license information exactly the same as specified in
the license you have got from the licenser. Note, the values are case-sensitive.

Click the button 'Activate’. The license you have entered will be verified and activated. A
message box will display the validity of the license. Close the message box.

Note: If the message box shows that the license could not be activated, verify the license information you have
entered and correct them if needed. Then repeat the license activation.

Close the 'License Activation' dialog.
Restart the application as usual. All of its features are unlocked now.
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